
 
 

 

 
 
 
 

Getting Started with 

 



Welcome 
 

Welcome to REMI PI+. Your program package includes both regional and national data models. 

The regional data and model have been calibrated to the region(s) that you specify at purchase, 

and all packages include a Windows® point-and-click interface that makes them easy for all 

levels of computer users. 

What Is REMI PI+? 
REMI PI+ combines decades of economic experience with an easy-to-use software interface. The 

REMI model is a dynamic model that forecasts how changes in the economy and adjustments to 

those changes will occur on a year-by-year basis. The model is sensitive to a very wide range of 

policy and project alternatives and to interactions between the regional and national 

economies.  By pointing and clicking, you can answer the toughest “What if…?” questions about 

federal, state, local, or regional economies. 

Founded in 1980, Regional Economic Models, Inc. (REMI) constructs models that reveal the 

economic and demographic effects of policy initiatives or external events on a local economy. 

PI+ model users include national, regional, state, and city governments, as well as universities, 

nonprofit organizations, public utilities, and private consulting firms. 

REMI is dedicated to continuing economic research combined with quality customer service and 

support. 

  



System Requirements 
 

We recommend that your computer system meet the following specifications. PI+ may run on 

systems below these minimum specs, but functioning is severely impaired.  

• Windows 2000, XP, or Vista (32- or 64-bit) 

• 1.4 GHz or faster processor 

• 1 GB RAM (2-3 GB for larger models, and for Windows Vista) 

• 2 GB of available hard-disk space (10 GB for larger models) 

• 1024x768 display 

Simulation execution time increases exponentially with the number of regions and industry 
sectors. Large models (i.e. >25 regions for 23 industries, >12 regions for 70 industries, and 
>6 regions for 169 industries) benefit greatly from increased memory capacity and 
processor speed1.  

  

                                                            
1 For example, on a computer with a 3 GHz Intel Core 2 Duo processor and 3 GB of RAM, a 3 region model with 70 
industries will run a 25 year forecast in 6 seconds, while a 51-area model takes 14 minutes.  



Installation 
 

IMPORTANT NOTE:  You must have Windows administrative privileges to install this software.  

When you are ready to install REMI PI+, insert the CD provided into your CD-ROM drive.  The 

InstallShield installation utility should run automatically.  If it does not appear, select your CD 

drive in “My Computer” (XP) or “Computer” (Vista) and double-click “setup” or “setup.exe” to 

start the installation process.  A shortcut to the application will appear on the desktop once the 

installation is complete. 

Contact REMI or your system administrator if you need assistance with installation or operation 

of the software. 

  



Running a Simulation 
 
To start PI+, double click on the shortcut appearing on your desktop. 
 

 
 
 
The Welcome screen will display at startup unless you uncheck the box on the lower left hand 
corner. Use the scroll bar on the right hand side to view the text.  When done, click the close 
button to exit this screen. 
 

 
 
Now you will be viewing the Home tab.  Note the default name of the workbook located on the 
header when you first open PI+ is Untitled.rwb. You will have the opportunity to rename this 
document when you save a new forecast.  The name of the specific model is located on the 



status bar at the bottom of the window. The ribbon displays three groups, Add a Forecast, 
Views, and About.  The Workbook view is the default, and contains the Standard National 
Control and Standard Regional Control upon first starting. The Inputs view is empty until 
running additional forecasts, and the Results view gives you the option of displaying the history 
and forecast of any controls or simulations stored in the workbook.  The About group provides 
access to Model Details such as the national input output table, and to the REMI website, 
where additional information and documentation may be found. 
 

  
 
To start a new simulation, click on the Regional Simulation button.  The Insert tab now appears. 
 



 
 
The Insert tab organizes policy variables into three logical groups, with the most structured 
approach in the Blueprints group, a more moderately structured approach in the Scenario 
group, and the least structured approach in the Lists group.  Tools are available to assist with 
filling in values for previously selected policy variables (Calculator and Spreader) and 
Importing/Exporting policy variables to or from other applications.  
 
In order to model an Economic Scenario, such as a plant shutdown, click on the Economic 
button, and select Employment & Sales. 
 

 
 
 



The Selector and Editor grids appear.  Give the scenario a meaningful name, such as “XYZ Job 
Losses.” Read the scenario description for helpful information and hints applicable to the 
selection. 
 

 
 
In the Selector grid, choose from applicable groups, in this case, Firm Behavior or Industry 
Behavior.  A description of each appears in the information box. If you know that XYZ is a 
manufacturing company, but you are not sure whether or how much it supplies the local 
region, choose Firm Behavior.  
In the Category box, choose Firm Employment, since for this simulation we only know the 
number of direct jobs being lost.  This selects the specific policy variable to be changed.  Read 
the information box for additional notes regarding the policy variable. 
 



 
 
In the Detail box, select the industry that XYZ is classified as.  In this example, assume it is 
Machinery manufacturing.  In the Region box, select the region where the plant is located, 
which is Hartford County.  In the Units box, select the appropriate units matching your inputs, 
in this case Units (number of individual jobs). When ready, click the Insert Into Editor button. 
 



 
 
The Editor grid now displays the policy variable selected. Enter job losses, with a negative value, 
by year. Since the value will be constant throughout the forecast period to reflect permanent 
job losses, the calculator may be used to automatically fill in the values for all years.  To do this, 
highlight the range of cells, in this case 2009-2050, and click on the Calculator button on the 
Tools group of the ribbon. Enter the value to be filled in each year, in this case 675 (for a job 
loss of 675 employees).  Then click OK. 
 

 
 
The Editor grid is now filled with a time series of the value entered.  If this is the only desired 
policy variable change (perhaps because it is the only input information available), click the 
button at the bottom of the screen, Add to Inputs List. 



 

 
 
The Policy Variable Inputs view now displays, listing the policy variable category just created.  
Click the open button to see the details. 

  
 
In this example, only one policy variable is listed.  If multiple variables had been selected, then 
would also be listed here.  Note that no changes to either policy variables or values may be 
made here, except to make them inactive or active by unchecking/checking the box .   
Only active variables will be included when the simulation is run.  To go back and edit policy 
variables or their values, click on the edit button , which will take you back to the 
Selector/Editor grid. It is a good idea to give the forecast a meaningful name, such as XYZ Plant 
Shutdown.  You may also determine the appropriate baseline which the simulation will be 
compared to (the Standard Regional Control is the default and only option unless the user has 
created other alternatives). Also, determine the length of the forecast to be run (2026 is the 
default, which represents a 20 year time horizon; the maximum year is 2050).  When ready to 
run the simulation, click the Run Now button.  
 



 
 
A status bar displays stating the elapsed time and estimated time remaining.  Models with a 
small number of regions will run in only a few seconds on a fairly fast computer. 
 

 
 
When the forecast has completed running, the Results tab appears. It is helpful at this time to 
maximize the application display so it fills your monitor screen, if you have not already done so. 
 

 
 
The default view shows Summary concepts displayed as both a table and a line chart. The 
Display group on the far left of the ribbon also provides a map view for multi-region models. 
One, two, or all three views may be activated at a time.  
 



 
 
The Display group also has buttons for adjusting decimal precision, chart type, and allows 
pivoting of the data to rearrange the layout of the grid. 
 
The Data group provides buttons for viewing the data as levels, percent change, or differences. 
It also allows the Years, Regions, and Forecasts viewed to be adjusted. 
 
The Economic Tables group presents all of the model’s economic variables in organized tables. 
The Demographic Tables group presents all of the model’s demographic concepts into 
organized tables. 
 
The Special group includes Analytical Graphs, which are useful for tracing cause and effect 
relationships for specific model equations, Custom Tables, which allows you to edit and create 
tables according to your own needs, and access to several Extras, such as DevSight.  
 
The Export group allows you to save a table to another format for easy import into other 
applications, such as a spreadsheet. 
 
When done viewing the simulation results, close the Results tab window by clicking on lower X 
in the upper right hand corner.  
 

 



Then close the Insert tab window by clicking again on the lower X in the upper right hand 
corner. You will be prompted to save the forecast to the workbook. Click Yes. 
 

 
 
Then you will be prompted to give the workbook a name, such as XYZ Plant. Then click the Save 
button. 
 

 
 
Your Workbook view will now display the XYZ Plant Shutdown simulation.   
 



 
 
To reexamine the policy variable inputs, simply double click on the Policy Change box of the 
flow chart.  To reexamine the simulation results, double click on the XYZ Plant Shutdown box.  
 
Likewise, the Standard Regional Control and Standard National Control data may be viewed by 
double clicking on those respective boxes. 
 
To close the application, click on the top X in the upper right hand corner. 
 

 

  



Other Features and Usage Tips 
 

Cumulating Policy Variables and Understanding Results 
 

A. Selecting and Activating Variables 
 
Introducing one policy variable at a time into a simulation facilitates understanding how the 
specific choice and magnitude of the input affects the net results. This may be especially useful 
when there are different or offsetting components that make up the analysis. 
 
This process is best illustrated with a simple example. Say a state or local government is 
considering increasing its general level of services and plans to finance this with an increase in 
personal taxes. Running these two policy variables together will generate the net results, but 
this will not necessarily give the analyst a feel for the magnitude of the positive impact of the 
new spending versus the negative impact of the new taxes. By running the simulation in a 
cumulative fashion, the individual effects as well as the net effects can be understood. 
 

Step 1: Start a new Regional Simulation. Click the Topics button on the Insert tab ribbon, 
and select Consumer Taxes. In the Selector grid, click on Government Spending 
(amount), and choose the proper units, in this case 2008 Chained National $ (M). 
Click Insert into Editor, and enter a value of 100 for each year for 10 years, beginning 
in 2010 ($100 million per year from 2010-2019).  

 

 



 
Step 2: To add the second policy variable, click on Personal Taxes (amount), choose the 

equivalent units used previously (2008 Fixed National $ (M)), Insert into Editor, and 
enter a value of 100 for the same years (2009-2019).  Then Add to Inputs List. 

 

 
 

Step 3: The Policy Variable Inputs View shows both policy variables. For the first 
simulation, we want to run one alone, so deactivate the Personal Taxes policy 
variable by unchecking the active box. 
 

 
 
Name the forecast, in this case, $100M Government Spending Alone, and set the run to 
year to 2019, since we are only interested in a 10 year time horizon. Then click Run 
Now. 

 



 
 
The results show the effect of the additional government spending only, which leads to positive 
employment changes. 
 

 



Step 4: Close and save this forecast to a new workbook. The Workbook view now shows 
the saved simulation. 

 

 
 
To copy the policy variables already selected to a new simulation, click on the Policy Change 
box, and then go to the Quick Access Tool Bar in the upper left hand corner of the application 
and click on the paste button .  Give the simulation a meaningful name, in this case, $100M 
Government Spending with Tax Increase, and click OK. A new forecast branch is now visible. 
The new forecast name is currently ghosted because the forecast has not yet been run. 
 



 
 

Step 5: Double click on the Policy Change box in order to access the Policy Variable 
Inputs window.  Since an exact copy of the policy changes from the first simulation 
was made, the Additional $100M Personal Taxes policy variable is still inactive.  To 
active this variable, click on the check box. Change the run to year to 2019, and click 
Run Now. 



 
 
The results now displayed are net for both the additional $100M of new government spending, 
and the additional $100M of new personal taxes.  
 

 



 
Step 6: You are now ready to analyze the results. To see the effect of just the increase in 

personal taxes, click on the Forecast button on the Data group of the Results tab 
ribbon, and select the $100M Government Spending Alone forecast for comparison. 
Click OK. 

 

 
 
The Results now reflect just the additional taxes, which leads to a loss of jobs. 
 

 



 
So by going through the policy variable selection process just once, you have been able to 
generate results for three different simulations, government spending alone, government 
spending combined with additional personal taxes, and personal taxes alone. Each policy 
variable generates a change in many of the endogenous variables of the model and it is 
important to be able to understand how the final results of a simulation are influenced by the 
specific policy variables that are used. By seeing the effects of each policy variable change, you 
will be better able to explain the final result when all of the variables are combined. 
 

B. Using Analytical Graphs to Understand Results 
 
Analytical Graphs are organized to illustrate the main determinants of key variables of the 
model.  By stepping through the graphs, you can quickly see the percent change in a key 
variable as well as that variable’s main determinants, allowing you to isolate the primary cause 
and effects of the simulation changes. 
 
Looking at the $100M Government Spending Alone simulation (compared to the Standard 
Regional Control), the State and Local Government Spending Determinants chart illustrates the 
total percent change to State and Local Government Spending, which is a combination of both 
the direct $100M input as well as the indirect effect of a slightly higher population and 
economy (measured in Total GDP). 
 

 
 
The effect on employment can be explained by viewing the Total Employment Components 
chart. A change in government employment leads the way, which is logical since the direct 
input was additional government spending, most of which, on average, is used to support 



employment. The change in Private Non-Farm Employment is the indirect effect of the 
additional government spending. 
 

 
 
To better understand the change in Private Non-Farm Employment, you can look at the Private 
Non-Farm Employment Components by Demand Source chart, which shows the percent change 
in employment by type of demand. Consumption and Intermediate Demand are typically the 
largest components of demand, so these changes track the most closely to the overall change in 
Private Non-Farm Employment. The additional government spending led to an increase in 
consumption primarily due to the spending of compensation earned by the new government 
employees. The intermediate demand increased due to additional demand by consumers as 
well as direct spending of the government on supplies, etc.   
 



 
 
Looking at the $100M Tax Increase Alone simulation (compared to the Standard Regional 
Control), the Real Disposable Personal Income per Capita Determinants chart illustrates the 
total percent change to Real Disposable Income, as well as the percent change in Real 
Disposable Income per Capita, which is also affected by the percent change in Population. 
Increasing personal taxes leads to additional outward flow of economic migrants (due to the 
increased cost of living in the area), which lowers the overall population, mitigating the percent 
change in Real Disposable Income per Capita compared to the percent change in Real 
Disposable Income. 
 

 



 
The Consumption Determinants chart shows the percent change in Consumption, as well as the 
primary causes for this, Population (by age cohort) and Real Disposable Income per Capita. A 
smaller population and less income per person result in less consumption. 
 

 
 
The Final Demand Components chart shows the percent change in major components of GDP. 
The overall negative effect on the economy (driven by less consumption) leads to less fixed 
investment over time, due to a smaller optimal capital stock.  
 

 



The effect on employment can be explained by viewing the Total Employment Components 
chart. Private Non-Farm Employment shows the largest decrease in terms of percent change. 
 

 
 
The overall loss of jobs is primarily explained by the decrease in demand for Consumption, 
Investment, and Intermediate goods. 
 

 
 
 



Getting Additional Help 
 
Help is available in the following forms: 

• REMI Technical Support 

• REMI’s Web site, www.remi.com 

Contacting REMI Technical Support 
You may contact REMI Technical Support at 413-549-1169. Be sure to be sitting near your 

computer so a REMI support person can help you with your problem. 

REMI’s Web Site 
REMI’s Web site, www.remi.com, contains a Frequently Asked Questions (FAQ) page, a glossary 

of terms, and extensive product documentation.  There is also a listing of upcoming REMI 

conferences. You can also ask a question of REMI staff by sending an e-mail to info@remi.com. 

 

http://www.remi.com/
http://www.remi.com/
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